
Title: Analysis of Multispectral Imagery 

Brief Overview: 

Earth Resources Satellites, such as Landsat, record data in a multispectral format. Data is 
separated into several different bands each of which is highly sensitive to a particular 
portion of the visible and infrared spectrum. Vegetation patterns, land forms, and water 
resources can be studied and analyzed using these images. Combining image data with 
maps and other geographic or geologic resources yields a wealth of information about 
planet Earth. This Learning Unit focuses on the process of image analysis using Multispec 
Software. 

Links to NCTM 2000 Standards: 

• Data Analysis 
Students use the Multispec software to analyze spectral data values, and create graphs to 
display these values. 

Links to National Science Education Standards: 

• Science as Inquiry 
Students use computers and software to analyze and display Multispectral Image data. 

• Physical Science 
Students apply their understanding of the Electromagnetic Spectrum, specifically the 
Visible and Infrared portions to analyze and interpret Earth Resources data. 

• Science in Personal and Social Perspective 
Students learn how to interpret satellite data, and how it is used in analyzing natural 
resources and environmental factors. 

Grade/Level: 

Grades 9 - 12 

Duration/Length 

1 day 

Prerequisite Knowledge: 

Students should have a working knowledge of the following skills: 

• Map reading 

Student Outcomes/Objectives: 

Students will: 

• achieve an understanding of how to utilize satellite data in Earth Resources analysis. 
• gain insight into how satellite data may be used to detect changes in the Earth System 

over time. 
• understand the importance of spectral patterns in determining the physical characteristics of 

the land forms and vegetation imaged by satellites. 



Materials/Resource/Printed Materials: 

• Computers with Internet connection 
• Multispec Software and User’s Manual available free from Purdue University


Download site: http://dynamo.ecn.purdue.edu/~biehl/MultiSpec/

• Landsat Image files available free from NASA 

Download site: http://observe.ivv.nasa.gov/nasa/education/tools/stepby/archive.html 
• Maps of Washington D.C. 
• General information about D.C. and surrounding areas. (This may be obtained through 

tourist information brochures which are normally free.) 

Development/Procedure: 

• Before beginning the lesson, do the following: 

• Download the software, manual, and the Landsat image of Washington D.C. (available at 
the above websites). 

• Install the software on a computer according to the instructions on the website. Both 
Multispec and the image files are self-extracting .exe files. It is recommended that the 
teacher reads the manual for Multispec and becomes familiar with the software. 

• Begin lesson with explaining the Landsat spectral bands and the electromagnetic spectrum, 
with emphasis on the visible and infrared regions of the spectrum. See Attachment 1 for 
background information. Provide students with the list of Landsat spectral bands. 

• Have the students open the image DC.lan. The default for this image is 3-channel color, 
with Channels 4, 3 and 2 in red, green, and blue respectively. View the image with the 
default settings first. Ask the students if they can guess or interpret what type of surfaces 
the different colors represent. See Attachment 2 for explanation. 

• Give students the maps of Washington D.C. and, if they are not familiar with the region 
provide them with information materials of what can be found in D.C., i.e., The Mall, the 
White House, Lincoln Memorial, Airports, etc. 

• Have the students locate items listed in Attachment 3, Student Worksheet 1. This exercise 
serves to familiarize students with looking at image data and detecting features. 

• Instruct the students to separate the image into the different spectral bands by selecting 
Process - Display Image - Type - Side by Side Channels. This provides seven different 
gray scale images, one for each spectral band. Also, in the Options Menu select New 
Selection Graph. This will display a window showing a graph of reflectance values 
between 0 and 255 for a selected pixel or region for each band. A higher value indicates 
higher reflectance. Copies of the images are included. 

• Use Attachment 4, Student Worksheet 2, and have students describe and explain why 
different features are more easily identified in certain bands. Example: Locate the 
Georgetown Reservoir, McMillan Reservoir, and the Tidal Basin (next to the Thomas 
Jefferson Memorial) on a map. Have the students look at these locations in the different 
spectral bands. The reservoirs and the basin become easily distinguishable in bands 4, 5, 
and 7, i.e., the infrared bands, because of their low  reflectance in these bands compared to 
surrounding areas. This type of analysis would be used to distinguish between types of 
surfaces. 



• Have students change the display settings in accordance with instructions on Attachment 5, 
Student Worksheet 3, and explain high/low reflectance values for different surface features 
in the respective channels. Students should use the list with Landsat spectral bands to aid 
them in this exercise. 

• There are two options for displaying spectral values for a selection; using the Selection 
Graph or using the List Data command in the Processor Menu. Student Worksheet 3 
explains how to use the List Data command. Once students have completed this 
Worksheet instruct them to look at the selection graph when they click in different areas of 
the image. They should detect that the scale is changing. Ask students to suggest a different 
graph type to display the spectral values for the features. Sample graphs are included in 
Attachment 6. 

Assessment: 

3	 Student displays understanding of spectral patterns and their use in Earth 
Resources analysis by successfully and correctly completing the worksheets. 

2	 Student successfully completed Worksheets 1 and 2 and portions of Worksheet 3. 
Displays some understanding of spectral patterns. 

1	 Student successfully completed Worksheet 1, but had difficulty with 
Worksheet 2. Did not complete Worksheet 3. 

0	 Student was not able to complete any of the Worksheets. 

Extension/Follow Up: 

Have students select different images from the website. Students can work independently 
or in teams to perform an image analysis and then prepare a paper or a presentation 
describing their image and its features. 
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Attachment 1 

The Electromagnetic Spectrum 

The Electromagnetic Spectrum is comprised of energy at different wavelengths, ranging 
from very long wavelengths, such as Radio- and Microwaves, to very short wavelengths, 
Gamma rays. Visible light and Infrared Radiation are the most important portions of the 
Electromagnetic spectrum when Landsat images are analyzed. 

Visible light ranges in wavelengths from 700 nm (nano meters, 1 nm = 10-9 meters) to 400 
nm, and is separated into seven different colors, red, orange, yellow, green, blue, indigo 
and violet. 

Landsat Spectral Sensor 

All different surface types on planet Earth reflect and absorb light in different ways. This 
spectral reflectance can be thought of as a fingerprint for a surface. The Landsat satellite 
measures this reflectance in seven different bands. Large areas of the planet can be analyzed 
for their vegetation and water content, mineral resources, urban expansion etc. 

Band	 Wavelength Description Used for 
(micro-meters) 

1 .45 - .52 Blue Visible Mapping water near coasts, mapping 
forest types, differentiating between 
soil and plants, identifying human 
made objects such as roads and 
buildings. 

2 .52 - .60 Green Visible Differentiating between types of plants, 
determining the health of plants, identifying 
human made objects. 

3 .63 - .69 Red Visible Differentiating between plant species, and 
identifying human made objects. 

4 .76 - .90 Near Infrared energy Determining plant types and health, and 
detecting boundaries of bodies of water. 

5 1.55 - 1.75 Mid-infrared energy Distinguishing snow from clouds, and 
determining soil moisture content. 

6 10.4 - 12.5 Thermal-infrared Determining relative temperature and 
amount of soil moisture. 

7 2.08 - 2.35 Mid-infrared energy Differentiating between mineral and rock 
types and detecting how much moisture 
plants are retaining. 

When spectral bands are displayed separately in shades of gray, the lighter gray tones 
represent objects with higher reflectance in that band, the darker objects have lower 
reflectance. 

Data from the Landsat satellites is available from year 1972 until present, making it feasible 
to detect changes in Earth’s resources over time. 



Attachment 2 

The default setting for the DC image file is:


3-channel color


where the computer is instructed to display 


Channel 4 Near Infrared energy as RED 

Channel 3 Visible Red light as GREEN 

Channel 2 Visible Green light as BLUE 

Note that the computer display colors, RED, GREEN and BLUE are not the same as the 
Visible Light spectral bands. This is a FALSE color image. 

Changing the channels as follows creates a TRUE color image: 

Red Channel 3 

Green Channel 2 

Blue Channel 1 

In this type of image the computer is instructed to display Visible Red light as RED, Visible 
Green light as GREEN, and Visible Blue light as BLUE. 

In the FALSE color image RED is used for Near Infrared energy. Vegetation and land have 
very high reflectance in the Near Infrared band, while water absorbs almost all of the 
energy in this band. The RED areas on the image are different types of vegetation. Different 
shades of red indicate different types of land or vegetation. 

The blue/green/gray color indicates human made structures, roads, bridges etc. These types 
of surfaces reflect RED, BLUE, and GREEN visible light, but have lower reflectance in the 
Near Infrared band. 

The Potomac River and other water resources range from green to black in color, 
depending on the depth and clarity of the water. Deeper water is darker. 



__________________ 

__________________ 

__________________ 

__________________ 

__________________ 

__________________ 

__________________ 

__________________ 

__________________ 

Attachment 3, Student Worksheet 1 

In the View menu select Coordinates Bar 
This will show display coordinates for a selection. 

Locate the following features on the image of Washington D.C. and write down the 
approximate display coordinates: 

Feature Display Coordinate(s) 

The Mall 

The Capitol Building 

Mason Memorial Bridge 

Arlington National Cemetery 

Washington National Airport 

The White House 

McMillan Reservoir 

The Pentagon 

RF Kennedy Memorial Stadium 



Attachment 3, Answer Key 

McMillan Reservoir 

The White 


Arlington National The Capitol
Cemetery Building

The Mall 

Mason Memorial Bridge 

The Pentagon 

RF Kennedy Memorial 
Stadium 

House 



__________ ______________________ 

______________ ______________________________ 

______________ ______________________________ 

______________ ______________________________ 

______________ ______________________________ 

Attachment 4, Student Worksheet 2 

Locate the following features and explain in which spectral bands they are the most easily 
distinguishable and why. 

Feature: Easily Distinguishable Reason 
in Band(s) 

Georgetown Reservoir 

Tidal Basin 
(near Lincoln Memorial) 

Rock Creek Park 

Runways at National 
Airport 

The Capitol Building 



Attachment 5, Student Worksheet 3, Example 

Instructions: 

Change the display settings to a single band according to list below. To change display 
settings do the following: Go to Processor Menu - select Display Image - select Display 
Type: in the drop down box select type - in the Channels box type in the channel number. 

Have Selection Graph open. Options Menu - New Selection Graph. 

Select Coordinates bar from the View Menu. 

Click on the listed feature and then go to Processor - List Data - Click OK. This command 
will list spectral values for the selected coordinate and output to the Text Screen. Note that 
values will differ slightly depending on where in a particular area you click. 

Display Type Channel(s) Type of   FeatureReflectance values for 
reflectance each channel 

Example: 
3-channel color Red: 4 Near Infrared McMillan 1: 63 

Green: 3 Visible Red Reservoir 2: 23 
Blue: 2 Visible Green 3: 15 

4: 7 
5: 6 
6: 132 
7: 2 

Explanation: McMillan reservoir is a water surface. Water reflects blue visible light, higher 
value in Channel 1, and absorbs Visible Red and Green, lower values in Channels 2 and 3. 
Almost no infrared energy is reflected, low values in Channels, 4, 5, 7. Channel 6 -
Thermal Infrared measures relative temperature and soil moisture. To appreciate the thermal 
difference between surfaces it is best to use the 1-Channel Color setting and select Channel 
6. This image shows that the Reservoir is cooler (dark in the image) than for example the 
center of the city (very bright). 



____________ 
____________ 
____________ 

____________________________________________________________________ 
____________________________________________________________________ 
____________________________________________________________________ 

____________________________________________________________________ 
____________________________________________________________________ 
____________________________________________________________________ 

______________________________________________________________________ 
______________________________________________________________________ 
______________________________________________________________________ 

Attachment 5, Student Worksheet 3 (Continued) 

Display Type Channel(s) Type of   FeatureReflectance values for 
reflectance each channel 

3-channel color Red: 4 Tidal Basin 1:____________ 
Green: 3 2:____________ 
Blue: 2 3:____________ 

4:____________ 
5:____________ 
6:____________ 
7:____________ 

Explanation:__________________________________________________________ 

3-channel color Red: 4 ____________ Georgetown 1:____________

Green: 3 ____________ Reservoir 2:____________

Blue: 2 ____________ 3:____________


4:____________

5:____________

6:____________

7:____________


Explanation:__________________________________________________________ 

Both the Tidal Basin and the Georgetown Reservoir are water surfaces, yet it is evident that 
their reflectance patterns are different. Can you think of an explanation to this? 



____________ 
____________ 
____________ 

____________________________________________________________________ 
____________________________________________________________________ 
____________________________________________________________________ 

____________________________________________________________________ 
____________________________________________________________________ 
____________________________________________________________________ 

_____________________________________________ 

Attachment 5, Student Worksheet 3 (Continued) 

Display Type Channel(s) Type of   FeatureReflectance values for 
reflectance each channel 

3-channel color Red: 3 Rock Creek 1:____________ 
Green: 2 Park 2:____________ 
Blue: 1 3:____________ 

4:____________ 
5:____________ 
6:____________ 
7:____________ 

Explanation:__________________________________________________________ 

What type of image is this? True or False color?_____________________________ 

3-channel color Red: 5 ____________ East Potomac 1:____________

Green: 4 ____________ Park 2:____________

Blue: 2 ____________ 3:____________


4:____________

5:____________

6:____________

7:____________


This location is close to the Tidal Basin. 
Explanation:__________________________________________________________ 

Note. This band combination is good for separating trees and grassland. Comparing Rock 
Creek Park and the East Potomac Park which has the lightest green color? 

Knowing that East Potomac Park houses a golf course what type of vegetation do you 
think that this shade of green represents? Trees or grasslands? ___________________ 



Answer Key to Worksheet 2 

Feature:	 Easily Distinguishable Reason 
in Band(s) 

Georgetown Reservoir 4, 5, 7	 Water. Low reflectance in the 
infrared region. Makes it 
stand out. 

Tidal Basin 
(near Lincoln Memorial) 4, 5, 7	 Water. Low reflectance in the 

infrared region. Makes it 
stand out. 

Rock Creek Park All bands. Least visible Vegetation. Displays enough 
in band 5. difference to surrounding 

areas in almost all bands to 
make it easy to see. 

Runways at National 
Airport 4, 5 	 Darker than surrounding 

areas in these bands. Band 6 
shows that the Airport region 
is hotter than surrounding 
areas. 

The Capitol Building 1, 2, 3	 High reflectance in the visible 
bands, compared to the 
surrounding lawn. 

Answer Key to Worksheet 3 

Channel Tidal Basin Georgetown Rock Creek Park East Potomac Park
 Reservoir 

1: 57 73 52 59 
2: 23 36 19 24 
3: 21 28 14 18 
4: 9 8 85 106 
5: 2 3 48 88 
6: 130 128 124 135 
7: 1 1 11 23 

Please note that these values are approximate and depending on exactly where on the image 
the students place their cursors. You can elect to give them exact coordinates by having 
students type in exact coordinate values in the List Data command. 



Attachment 6, Sample Graphs 
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